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LUCIS Software Orientation for The
Church Accountant User
A number of differences exist between The Church Accountant and the new LUCIS Software
Standard Edition. This chapter will compare the two and help you understand how to get around in
the new LUCIS Software from the perspective of a Church Accountant user. This document
assumes use of the LUCIS Standard Edition – higher level editions have more features.

Menus

(Back to Top)
The Church Accountant menu is made up of two distinct modules: Contributions & Deposits,
and General Accounting. The combined menus for both modules are on the Main Menu page.

The LUCIS Software has a manager screen that is available the entire time the software is active
and is used to activate specific functions. Its menu contains a primary entry for each module – only
modules covered by your license will appear.

The primary modules used for churches are the Address Book module (no direct equivalent in
The Church Accountant), the Donations module (equivalent to Contributions & Deposits), and the
General Ledger module (equivalent to General Accounting). Clicking on a menu item will cause a
drop-down menu to display the menu choices for that module – the menu choices are equivalent to
the number and alphabetic selections made in The Church Accountant.
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DONATIONS

(Back to Top)
The LUCIS Software Donations module is the replacement for The Church Accountant
Contributions and Deposits module.

DONATIONS: Offerings

(Back to Top)
Though the format of offering codes remains the same as The Church Accountant some major
differences exist in the way offerings are set up using the new DN Offering Editor and DN Add
Offering Wizard.
Offering Code vs. Account Number – The Church Accountant offering codes were actually
ledger accounts – to set up an offering you set up a general ledger account that was then used directly
by the contributions module.
In the new LUCIS Software the offering code and the general ledger account number to which it
is posted are set up separately and then "linked" together. This allows the donation module to work
with all ledger levels in the LUCIS Software, as well as third-party software, even though account
number formats may be incompatible with the format of offering codes. It also allows multiple
offering codes to be posted to the same ledger account (e.g., all remittance offerings should be posted
to ledger account 80 – the Church Accountant required each offering to have its own ledger account).
An offering code is set up using the DN Offering Editor or DN Add Offering Wizard and
"linked" to a ledger account by identifying the "Post to Acct#" (see below). Use offering codes only
for actual offerings (not misc. income). Remember, offering codes are separate from ledger
accounts—all ledger functions (local funds) and accounts are set up using the GL Account Organizer
and balance, income and expense accounts are automatically created when you set up a new function
(local fund).

Offering Goals – A new feature in the LUCIS Software Donations module is the ability to
record a church-wide goal for any offering and compare actual giving to that goal. If a goal is not an
annual goal but rather a project goal intended to span years you may indicate "Multi-year".

2

Offering Identifiers – With the coding system previously used it has been difficult to maintain
positive identification of donor's intent for uncommon special offerings. Therefore, the LUCIS
Software for Windows is piloting an identification scheme to better identify the donor's intent when
remitting offerings. This scheme depends on two new identification components: the destination ID
and offering purpose. A remittance ID allows the receiving organization (the conference in the case
of churches) to maintain offering identifiers independent of offering codes used locally.

Offering Destination – The offering destination identifies the final recipient of the funds, NOT
the organization serving as a conduit e.g., the destination of an offering for a school in Africa would
be that school, not your local conference to which you remit the funds. The Adventist Entity Query
contains a list of all Adventist organizations recognized by the General Conference Archives &
Statistics (click ). Local offerings should specify your church as the destination – all offerings
coded for other than your church will automatically be included in the remittance to your conference.
Offering Purpose – The offering purpose identifies the intended purpose of the funds by the
destination organization. A Purpose Lookup contains a standard list of purposes (click ).
Remittance ID – You now have the ability to record an ID for remittance purposes independent
of the offering code you use for your purposes. The remittance ID is a conference-assigned ID that
may or may not resemble your offering code. This allows your conference to use whatever ID
structure fits its needs without conflicting with offering codes you use. The remittance ID is
included on the remittance report as well as the offering code you use.
Offering Lists – The DN Offering Lists (located under DN Reports in the menu) allows you to
create offering lists that include some or all of the preceding information. There is no Church
Accountant equivalent since offerings in that system were actually ledger accounts and part of the
chart of accounts. NOTE: Donations are included in DN Entry Lists.
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DONATIONS: Donors

(Back to Top)
Donors were set up and edited in The Church Accountant using the Name & Address Update (#1
in the Contributions section). The DN Donor Editor is the new equivalent.
Donor Name/Address – The LUCIS Software for Windows uses a unique method to identify
the parts of names/addresses. Basically organization names are entered normally (e.g., Acme
Enterprises) but a slash is used immediately before the last name of individuals to identify the last
name from the first. The city, state and postal code are also separated with slashes.

Giving Unit – A new donor unit coding is being introduced that is intended to refine future percapita analysis. Each donor record is identified as individual (a single person), joint (combined
husband-wife giving), or not applicable (organizations). The inclusion of children with immaterial
effect on total giving should not be considered when making these assignments.
Donor Notes – A new section has been added to allow you to record free-form notes in donor
records. These notes are not meaningful to the program but can be included on donor lists for your
reference. Use the notes for whatever purpose is useful to you.
Donor Pledges – A new feature of the LUCIS Software is the ability to track up to four pledges
for each donor. These pledges may be for the current year or multi-year (an example of multi-year is
a building project with donor pledges intended to be fulfilled over several years).
Most Frequent Offerings – Though not edited with the DN Donor Editor, a history of the most
recent/frequent 9 offerings for each donor is maintained by the system and can be viewed with the
Donor Editor. This history is also displayed on the donation entry screen when you identify a donor
to show the donor's history.
Donor Lists – The DN Donor Lists (located under DN Reports in the menu) allows you to create
donor lists that include some or all of the preceding information. The closest Church Accountant
equivalent is the Name & Address List (#A in the Contributions section). NOTE: Entries posted to
donors are included in DN Entry Lists.
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DONATIONS: Entries

(Back to Top)
The DN Open Batch Entry/Edit replaces The Church Accountant Contributions & Income Entry
(#2 in the Contributions section). However, there are some notable differences.

Receipt Amount – The Church Accountant allowed you to enter a single cash amount and/or a
single check amount. The new entry program has a single cash amount but allows you to enter up to
10 check or money order amounts. This is useful when you are processing an offering envelope with
several checks in it.
Donor Giving History – A history of the most recent/frequent 9 donation offerings for the
donor being processed is noted for your review. This information is automatically maintained by the
software based on entries posted. A list of the donor history information is included in DN Donor
Lists.
Editing – The Church Accountant allowed you to edit donations in the open batch using the
Contributions & Income Entry program but the process was not obvious. The new entry program
has a button at the top of the window that will activate a Donation Query to allow you to select
any entry set in the open batch for editing (an entry set is equivalent to an offering envelope). Unlike
The Church Accountant, however, it also allows you to delete an open entry set (The Church
Accountant only allowed you to delete the entire open batch, not selected entry sets).
Entry Lists – The Contribution Reports selection in The Church Accountant (#B in the
Contributions section) was used to produce various reports and lists of donations including the
remittance report. The new equivalents are DN Entry Lists and DN Remittance Report (both under
DN Reports).
Deposits – The Church Accountant Deposit (#3 in the Contributions section) had three main
functions: deposit lists, closing the open deposit, and posting a deposit to the General Ledger. These
are separated in the new LUCIS Software. DN Deposit List (under DN Reports) is used to produce
deposit lists, DN Close Open Batch is used to close the open batch, and DN Post Closed Batch to GL
is used as its name indicates.
Receipts – The Church Accountant Receipts (#C in the Contributions section) is replaced by DN
Donor Statements (under DN Reports).
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DONATIONS: Queries

(Back to Top)
A major feature of the new LUCIS Software is the powerful lookup queries. Everywhere you
are required to identify a donor, offering or entry you can activate a query-lookup-search window to
select one (or just find information). The queries allow you to sort and search your data to locate
specific records (they also have buttons to add new records or edit existing ones during the query
process). It is well worth investing time studying the query helps to learn how powerful and useful
they can be to you.
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DONATIONS: Monthly/Annual Close

(Back to Top)
Unlike The Church Accountant, the LUCIS Software now requires a formal monthly/annual
closing for donations.
Annual Close – The Church Accountant automatically performed an annual close (by creating a
new donation file set) when you confirmed you were closing the first batch for the new year. The
LUCIS Software allows you to close the donation year before you process your first batch of the new
year using DN Monthly/Annual Close.
If you do not perform an annual close before entering your first batch for the new year then the
entry program will allow you to close the old year before continuing.

Monthly Close – There was no monthly close for contributions in The Church Accountant. You
were expected to remember the range of batches for each month to identify months for reporting
purposes. The LUCIS Software has a formal monthly close so that you do not have to remember
batch ranges for each month but can refer to months for reporting.
A monthly close can be performed using DN Monthly/Annual Close before you enter your first
batch for the new month. If you do not perform a monthly close before entering your first batch for
the new month the entry program will allow you to close the previous month before continuing.
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DONATIONS: Reports

(Back to Top)
Donation reports in The Church Accountant consisted of Receipts and the Contribution Reports
selection.

Receipts – DN Donor Statements (under DN Reports) replaces The Church Accountant Receipts
(#C in the Contributions section). The new program provides additional operator-selected options.

Donation Reports – DN Entry Lists replaces the functions of The Church Accountant
Contribution Reports (#B in the Contributions section).

8

DONATIONS: Miscellaneous

(Back to Top)
The Church Accountant had several miscellaneous contribution functions (#9 in the
Contributions section) and a Backup (#Z in the Contributions section). Their equivalents are as
follows:
1) Organization and Printer Controls – the organization name and address are maintained
using the Company Info Editor in the File menu of the main LUCIS Manager window. Printer
controls are not applicable in the new LUCIS Software. The closest equivalent is the Print Setup
under Advanced Tools of the Tools menu of the main LUCIS Manager window.
2) Update Contribution Controls – this feature was used to access general controls for the
contribution module including those that were normally maintained automatically. DN Controls
Editor is the new equivalent.
3) Re-index Contribution Files – there is no equivalent in the new LUCIS Software (see #A
below).
4) Split Contribution History Files – not applicable in the new LUCIS Software.
5) Update Contribution History Account Number – not applicable in the new LUCIS
Software.
6) Rebuild Contribution History Account Table – not applicable in the new LUCIS Software.
7) Change Open or Closed Contribution Date – see Change Open Batch Date in Entries
menu item of DN Open Batch Entry/Edit or Change Closed Batch Date in Utilities menu item of DN
Close Open Batch for new LUCIS Software equivalents.
8) Delete Open Contribution Entries – the equivalent in the new software is DN Delete Open
Batch in the Donations menu. NOTE: to delete individual entry sets in the open batch use the Delete
feature of DN Open Batch Entry/Edit.
9) Change a Deposit Date – see #7 above.
A) Verify Contribution History File – a more powerful equivalent in the new software is DN
Verify Donations Data.
B) NAD Offering Codes Update – the purpose of this feature is now handled by the
Remittance ID in the DN Offering Editor.
C) Account Code / NAD Code Conversion Table – no longer applicable.
D) Print NAD Codes/Conversion List – no longer applicable.
Backup – A new, more flexible backup feature, DN Backup Donation File Set, replaces The
Church Accountant #Z Backup Contribution Files.
New Stuff – Besides features already referenced, the new LUCIS Software has a donation entry
import (DN Import Entries to Open Batch), data export capabilities (DN Export Donation Data), and
a monthly/annual close process (DN Monthly/Annual Close) in addition to more advanced reporting
features.
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GENERAL LEDGER

(Back to Top)
The LUCIS General Ledger module is the replacement for The Church Accountant General
Accounting module.

GENERAL LEDGER: Accounts

(Back to Top)
As mentioned in the DONATIONS: Offering section of this document, a major difference
between The Church Accountant and the new LUCIS Software is that general ledger account
numbers are now assigned independently from offering codes. Otherwise, an individual familiar
with The Church Accountant chart of accounts should be comfortable with the new chart of
accounts.
Accounts were set up and edited in The Church Accountant using the Account Update (#1 in the
General Accounting menu). The GL Account Editor is the new equivalent and is accessed via the
GL Account Organizer..

Banking Account – The Church Accountant tracked check numbers for a single bank account.
The LUCIS Software allows you to track check numbers for as many bank accounts as needed.
Once initialized check numbers are automatically maintained by GL Payments Entry.
Budget – Like The Church Accountant you may enter budget amounts for the current year as
well as budget amounts for the next year. The "Next Year" budget will automatically become the
"Current Year" budget in the new year after annual closing.
The Church Accountant used an automatic 1/12 monthly budget distribution for accounts.
LUCIS Standard ledgers provide an additional months checked option (not illustrated) that allows
you to indicate which months should be included for budget distribution. This option can be used
with income or expense accounts and is useful for seasonal expenses such as heating, insurance, etc.
Account Lists – GL Account Lists (under GL Reports) is the replacement for Account Lists (#A
in the Accounting section) of The Church Accountant.
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GENERAL LEDGER: Entries

(Back to Top)
The Church Accountant has three entry processes, the LUCIS Standard Edition has four plus an
entry import.

Payments Entry – The GL Payments Entry is the equivalent of Check Disbursement Entry (#2
in the Accounting section) of The Church Accountant. Each payment can include up to 99 lines of
account distribution. Checks may be printed and posted or, if already written manually, just posted.

Receipts Entry – A new entry procedure with no Church Accountant equivalent is GL Receipts
Entry. This entry is intended for income that does not need to be included in donations, e.g., interest
income, sales, etc. A demand receipt can be printed if desired.
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Transfers Entry – The new GL Transfer Entry feature replaces the Local Funds Transfer (#3 in
the Accounting section) of The Church Accountant. Besides allowing for a significant increase from
30 to 99 lines of entry, the new program makes setting up and using distribution templates more
useful and allows you to set up multiple templates whereas The Church Accountant only allowed
one. The balance of each local fund referenced is also shown to allow you to modify your
distribution at the time of posting if circumstances warrant it. You would do well to study the helps
for this feature.

General Entry – The GL General Entry (not illustrated) is a replacement for the General
Accounting Entry (#4 in the Accounting section) of The Church Accountant. The General Entry is
used for miscellaneous entries that are not applicable for the other entry features.
Import Entries – A new GL Import Entries feature (not illustrated) has no Church Accountant
equivalent. This is used automatically with the DN Post Closed Batch to GL feature of the
Donations module and can be accessed manually if needed.
Entry Lists – the GL Entry List (Journal) (under GL Reports) replaces the like-named feature
(#B in the Accounting section) of The Church Accountant.
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GENERAL LEDGER: Queries:

(Back to Top)
Like the donations lookup queries, the lookup queries for the general ledger are a major feature
of the new LUCIS Software. Everywhere you are required to identify an account or entry you can
activate a query-lookup-search window to select one (or just find information). These queries allow
you to sort and search your data to locate specific records (the query also has buttons to add new
records or edit existing ones during the query process). It is well worth investing time studying the
query helps to learn how powerful and useful they can be to you.
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GENERAL LEDGER: Monthly/Annual Close

(Back to Top)
The GL Monthly/Annual Close is the LUCIS equivalent of The Church Accountant
Monthly/Annual Closing (#5 in the Accounting section). Like The Church Accountant the new
LUCIS Software requires a monthly close to generate monthly amounts for reports.

The annual close sets up a ledger for the new year. However, unlike The Church Accountant
that only maintained ledger detail for three years (current, last, and previous), the new software will
maintain ledger detail indefinitely.

GENERAL LEDGER: Bank Reconciliation

(Back to Top)
GL Account Reconciliation is the equivalent of The Church Accountant Bank Reconciliation (#5
in the Accounting section) and works in a similar fashion.
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GENERAL LEDGER: Reports

(Back to Top)
General Ledger reports in The Church Accountant consisted of Account Balance Lists, Account
Ledger Reports (#D in the Accounting section), and Financial Reports (#E in the Accounting
section).
Account Balance Lists – GL Account Balance List (under GL Reports) replaces The Church
Accountant Account Balance Lists (#C in the Accounting section).
Account Ledger Reports – GL Ledger Report (under GL Reports) replaces The Church
Accountant Account Ledger Reports (#D in the Accounting section).
Financial Reports – GL Financial Reports (under GL Reports) provides for powerful financial
reporting tool than its Church Accountant counterpart (#E in the Accounting section). There are
selections for each category of financial report to choose from.
Balance Sheet – this is the standard report showing Assets, Liabilities, and Net Assets (the
new name for Fund Balance).
Financial Activity – the "Financial Activity STATEMENT" in The Church Accountant. It
lists the financial activity from the perspective of your church as a whole.
Function Summary – the "Financial Activity SUMMARY" in The Church Accountant. It is
a spreadsheet-type report showing single line for each function (i.e., local fund) with columns for
balance, income, expense, transfers, etc.
Function Detail – the "Financial Activity SCHEDULES" in The Church Accountant. It
shows the full account detail for each function (i.e., local fund). As in The Church Accountant you
may select specific functions or all. The new LUCIS Software also allows you to select a range of
functions.
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GENERAL LEDGER: Miscellaneous

(Back to Top)
The Church Accountant had several miscellaneous accounting functions (#9 in the Accounting
section) and a Backup (#Z in the Accounting section). Their equivalents are as follows:
1) Organization and Printer Controls – the organization name and address are maintained
using Company Info Editor in the File menu of the main LUCIS Manager window. Printer controls
are not applicable in the new LUCIS Software. The closest equivalent is the Print Setup under
Advanced Tools of the Tools menu of the main LUCIS Manager window.
2) Update Accounting Controls – this feature was used to identify the most active checking
account and the ledger fiscal. GL Controls Editor is the new equivalent with a few added items.
3) Re-index Accounting Files – there is no equivalent in the new software (see #4 below).
4) Verify Account Ledger – GL Verify Ledger Data is a more powerful equivalent.
5) Edit Account Transactions – GL Entries Editor is an easier to use equivalent.
6) List Unused Accounts – there is no equivalent yet in the new software.
7) Reverse Annual Closing – this feature is not applicable in the LUCIS Software since it
allows an infinite number of years of accounting data rather than a rotating three-year period used by
The Church Accountant. Use Delete File in the File Menu of the LUCIS Software Manager to get
rid of an unwanted ledger year.
Backup – A new, more flexible backup feature, GL Backup Ledger Files, replaces The Church
Accountant #Z Backup Contribution Files.
Vendor Names/Addresses – Vendor names and addresses were exclusively used and
maintained from the Payee entry area of Check Disbursement Entry (#2 in the Accounting section) in
The Church Accountant. Since this feature was somewhat hidden many did not know of its
existence. The new LUCIS Software has a separate Address Book module for names and addresses.
Churches primarily use this for vendors. Various address lists can be produced from this module.
The Address Book is linked to the General Ledger (via GL Controls Editor) for access to vendor
names and addresses. This link also allows Address Book records to be added and edited indirectly
via the AD Query when looking up addresses from the General Ledger entry programs.
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NEXT

(Back to Top)
To review the ongoing use of the software for churches see Using LUCIS Software: Churches.
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